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Microsoft Word
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WordPerfect 12

Two Heavyweight Word Processors
Go Head-To-Head
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www.microsoft.com

Corel WordPerfect Office 12
$299.99; $149.99 for upgrade =
30-day free trial

Corel

(800) 772-6735
www.corel.com

f you are looking into getting a new

office suite, you're aware that Micro-
soft and Corel have recently unleashed
their newest office products: Microsoft
Office 2003 and Corel WordPerfect Office
12. To help you make your decision on
which suite will best meet your needs,
we put the two packages to the test and
looked at some of the best features in
their main components.

In order to be as therough as possible,
we have broken our head-to-head review
into two parts: Part 1 will focus on the
waord processing programs. In Part 2,
which runs in next month's PC Today,
we'll look at each program’s spread-
sheets (Excel 2003 and Quattro Pro) and
the presentation programs (PowerPoint
20053 and Presentations 12).

Although the focus of this article is
on the word processors, we must discuss
the cost factor in terms of the price
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for each suite, Because
we will be looking at
the three main compo-
nents (word processor,
spreadsheet, and pre-
sentation programs)
in our two-part office
suite review, we will
use the price of Micro-
soft Office Standard
edition 2003 for our
comparison. (Micro-
soft Office 2003 is
available in multiple
versions; however,
there is only one real WordPerfect Office)

Corel WordPerfect Office 12 carries a
retail price of $299.99 ($149.99 for the
upgrade), while Microseft Office Stan-
dard Edition 2003 will cost you §399
(5234 for the upgrade).

At first glance, this price comparison
seems to indicate that WordPerfect
Office is the better deal. However, you
have to take into account the fact that the
Microsoft Office also includes Outlook,
whereas the WordPerfect suite doesn't
include an email or PIM (personal infor-
mation manager) program. As such, if
you were to add the cost of the stand-
alone version of Outlook 2003, which is
F109.99, to the cost of the WordPerfect
suite, you have a more level playing field
if you are comparing prices.

On the other hand, because we are fo-
cusing on the word processors, we'd be
remiss if we didn’t point out that
Microsoft Word 2003 is available as a
standalone package for a cost of $229

($109 for the upgrade). WordPerfect 12 is
only available as a part of the office suite.

If you're sitting on the fence and
really aren't sure which suite will work
best for you, you'll be glad to know
that you can sample each one be-
fore making a monetary commitment.
Microsoft offers a full-featured, fully
functional 30-day trial of the Office
Professional Edition 2003. Although
the trial software is free, you must
order it on a CD, which requires a $7.95
fee for shipping. For its evaluation
version, Corel offers a slimmed down
30-day trial of WordPerfect Office 12.
The free trial is available as a 152MB
download that only includes the main
components of the suite, but those
components are fully functional,

Now that we have addressed the
preliminaries, let's take a look at the
word processors,

If you have been using Microsoft
Word for a while, at first glance the 2000
version doesn’t really appear that much
different from its preclecessor. The inter-
face is a bit more refined, but nothing im-
mediately jumps out as new and exciting,
However, once you delve into the docu-
ment creation process, you'll encounter
some new and improved features, There
aren’t as many new word processing fea-
tures in Word 2003 as you might expect
from a major upgrade. But you have to
take into account that Microsoft's main
design goal for Office 2003, as a whole,
was the integration of collaboration, us-
ability, and information management fea-
tures aimed at using the suite in a cor-
porate enterprise environment.

Features to look for. Even so, Word
2003 is packed with features that let
you create impressive documents. To
get started, you'll find that Word comes
with an ample selection of fonts and
easy-to-use formatting options, as well
as a host of templates and document-
creation wizards. Many more are avail-
able for download from the Microsoft
Office Online Web site (www.office
.microsoft.com /home/ default.aspx).
Although a lot of these templates and




wizards are carryovers from previous
editions, Microsoft has enhanced many
of them.

Of course Word 2003 provides you
with a built-in spelling and grammar
checker. But when you go to access the
thesaurus, you'll discover that Microsoft
integrated it into a new feature called
the Research pane. The Research pane
appears in Word's Task Pane, which is a
sidebar-like panel that appears on the
right side of the document. In addition to
the thesaurus, the Research pane provides
acoess to a vatiety of online reference ma-
terial. For example, you can access the
Encarta Dictionary and Encyclopedia,
HighBeam Research's eLibrary, and even
MSN Search, just to name a few. Plus, you
can customize the Research pane and add
your favorite research services,

One of the most prominent new fea-
tures in Word 2003 is the Reading
Layout view, which is designed to make
reading documents on-screen easier on
your eyes. [f you choose to use this
feature, Word hides all of the toolbars
except for the Reading Layout and
Reviewing toolbars and configures the
interface to appear like an open book
with pages facing each other. To com-
plete the illusion, Word enhances the text
by using Microsoft ClearType, a typo-
graphical technology designed to im-
prove font display resolution such that
words on the screen look almost as sharp
and clear as those printed on paper.

Another new item to look for in Word
2003 is the Protect Documents feature.
This feature is a subset of the larger [RM
(Information Rights Management) policy
enforcement technology built into Office
2003 and designed to protect documents
and email messages from unauthorized
access and use. (The full [RM package is
only available in the Professional and
Enterprise editions of Office 2003 and re-
lies on a server running Windows Rights
Management Services )

Using the Protect Document feature,
you can restrict the formatting and ed-
iting capabilities of documents that you
share, or collaborate on, with others. For
example, you can lock a decument, esser-
tially making it a read-only document;
you can restrict editing and allow others

viewing the document te only enter com-
ments; or you can lock the Track Changes
option, which would allow viewers to
make changes but not disable the Track
Changes option. The Protect Document
feature also lets you create forms allowing
users to only fill in specified fields.

On the advanced feature front, Word
2003 has the ability to save XML (Exten-
sible Markup Language) documents
using the Word XML schema. The ad-
vantage here is that you can create docu-
ments in Word as you normally would
without worrying about XML details.

The rew Research pane in Microsoft Word
2003 provides access 1o the thesaurus, as well
a5 a host of other reference materials,
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The PerfectBxpert will guide you, step-by-
through all of the document creation features
that WordPerfect has to offer.

Then, when you save the file as XML,
the word processing program uses the
Ward XML schema, called WordML, to
automatically apply the appropriate
XML tags to the document. Documents
you create using the WordML schema
are compatible with standard XML such
that any software package that can parse
XML can read and process the data in an
XML document created with WordML.
When mentioning XML support, it's
important to point out that the version of
Word 2003 that comes with Microsoft

Oitfice Standard Edition 2003 doesn't pro-
vide all the XML features in the version
that is available with Microsoft Office
Professional Edition 2003 or the stand-
alone Microsoft Word 2003 package.

The folks at Corel, buoyed by Vector
Capital's recent acquisition of the com-
pany, have spent a great deal of time and
money redesigning their business pro-
ductivity suite and shifting the emphasis
away from a proprietary product toward
one that offers greater Microsoft Office
compatibility. As such, if you are cur-
tently using Microsoft Word, you'll feel
tight at home if you decide to make the
switch to WordPerfect 12,

You choose. As soon as you launch
WordPerfect 12, the new Workspace
Manager greets you, prompting you to
choose a user interface configuration.
You can choose among WordPerfect
Mode, Microsoft Word Mode, Word-
Perfect Classic Mode, and WordPerfect
Legal Mode. Each mode reconfigures the
look and feel of the main workspace
compoenents, such as toolbars, menus,
and shorteut keys, to emulate your inter-
face selection. Although the Microsoft
Word Mode is aimed at Microseft con-
verts, the standard, Legal, and Classic
mades are all designed to make it easy
for die-hard WordPerfect enthusiasts to
make the transition to this new version.
Of course, the WordPerfect Legal Mode
contains special features that cater to the
document creation needs of a law prac-
tice, while the WordPerfect Classic Mode
takes you all the way back to the sim-
plistic version 5.1: white text on a blue
screen interface complete with all of the
old-style keyboard shorteuts.,

When you choose Microsoft Word
Mode, the PerfectExpert feature opens.
PerfectExpert appears as a sidebar panel
to the left of your workspace. (In all
other modes, you must manually acti-
vate PerfectExpert from the Help menu.)
Acting like a task-oriented wizard, the
PerfectExpert will progressively assist
you in performing common and ad-
vanced word processing tasks with a
menu-like display that instantly acti-
vates options or opens the appropriate
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dialog boxes. As you work through a
task, PerfectBxpert's Back, Forward, and
Home buttons let you easily navigate all
the available options and steps.

Another feature designed to ease the
transition frem Word to WordPerfect, as
well as make it very easy to share docu-
ments with Word users, is the Microsoft
Word Compatibility toolbar. From this
handy little toolbar you can easily
save WordPerfect documents in Word
format, convert Word documents to
WordPerfect format, and launch the
WordPerfect Compatibility With Micro-
soft Word Help system where you can
find detailed information on the all
compatibility features.

When you switch documents from
Waord to WordPerfect, the conversion pro-
cess is very smooth and almost perfect. Of
couirse, basic documents often make it
through the conversion process better
than those documents that are heavily
formatted. You can avoid any conversion
troubles by referring to the conversion
reference in the compatibility Help sys-
tem mentioned previously. That way
you'll know ahead of time what anomalies
tor look for when converting documents.

Once you begin creating documents
in WordPerfect, you'll, of course, find all
of the standard word processing features
that you need to create documents. For
example, you'll find a generous offering
of fonts, formatting options, and tem-
plates, as well as a built-in spell checker,
dictionary, and thesaurus.

However, you'll also encounter a
whole slew of features designed to assist
you in creating more sophisticated docu-
ments. For example, WordPerfect lets
you publish your documents to PDF
(Portable Document Format), HTML,
and XML. Doing so is as easy as selecting
the appropriate Publish To command
from either the File menu or the Micro-
soft Word Compatibility toolbar.

When publishing to PDF, Waord-
Perfect Office 12 saves the file in Adobe
Acrobat version 5.0 format, which under
maost circumstances is sufficient. Pub-
lishing to HTML is also a very straight-
forward operation.

In addition to publishing documents
to XML, WordPerfect can also create
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and edit standard XML documents,
When working with XML, WordPerfect
automatically shifts into XML editor
made, which is a two-panel display that

gives you a structured view of your
document on the left and page view on
the right. For more detailed work, you
can access the XML Project Designer, a

Step Into The Ring

In the main part of our review, we look at each word processing program’s new
features. Here, we take off the kid gloves and dive into a more confrentational

comparison of the main features of each program.

Features

Corel WordPerfect 12

Dictionary

File conversion
{barches)

File export
(standard formats)

File import
(standard formats)
Font preview

Formatting con-
trols (Advanced)

Formatting features
Grammar checker

Help system

Multiple document
handling

Printed
documentation

Spell checker

Templates

The Chdord University Press dictionary is preinstalled in WordPerfect, so it
is readily available all the time and it provides good definitions. However,
not all words are available and you're prompted to purchase the Oxford
Concise Dictionary at a cost of abour $20.

The Word Perfect Office Conversion Unility pravides an interface char lets
you convert a variety of document formats te WordPerfect.

Using the commands on the Micrasoft Word Compatibility toolbar to
sawe documents in HTML XML (Extensible Markup Language), PDF
(Portable Document Format), and Word formats is very easy.

Can easily import HTML and Word documents from the File Open dialog
bose

Access the Font drop-down menu and a pop-up window displays a font
sample. If your cursor is pasitioned on text in a document, that text be-
comes the font sample and it temporarily switches o the highlighted font
The Reveal Codes window appears at the botrom of the workspace and
displays the text enclosed in the acrual formartting tags,

Formatting features are easily accessible from the Font and Format tool-
bars, a5 well as the Formar menu, Creating and editing styles is a sraight-
forward operation from the Styles dialog box

By default the Grammar-As-You-Co feature is disabled. Perform a manual
grammar check operation by selecting the Grammatik command on the
Tools menu.

The Help menu provides access to a traditional Help dialog box, the
PerfectExpert, the Corel TUTOR, and Word Help. You alsa have access to
the Corel Webs site. The Help dialog box contains a tab for easily searching
the Corel Knowledge Base.

Each document appears as a button in the application bar at the battom
of the workspace.

The regular-sized, 308-page user guide provides installation information
and containg task-oriented sections for each applicarion, Each section has
a separate index.

The Spell As You Co feature is enabled by default and immediately under-
linves milsspelled words. Perform a manual spell check by clicking a button
on the toolbar or by pressing CTRL-F1.

Selecting the Mew From Project command launches the PerfectExpert di-
alog box, which provides access to hundreds of templates. The additional
OfficeReady browser pravides you with thumbnail views of all the available
templates, as well as access to the WordPerfect Templates page on the
Corel Web site.

Saving WordPerfect documents in XML formar is easy with the Publish To
XML command. When you need to work more closely with the actual
XML tags, WordPerfect shifts into XML editor mode and provides access
1o its XML Project Designer,



separate application that works in con-
junction with the word processer and
lets you create layouts and templates by
assigning formatting to XML elements.

As you can see, when it comes to
word processing power, Word 2003 and

WaordPerfect 12 have a lot to offer and
can easily handle most common and
advanced tasks. Of course, you'll need
to balance your needs against each pro-
gram's feature set along with the cost of
the office suite. And speaking of the
suites, keep in mind that we'll contin-
ue with our head-to-head comparison

of Microsoft Office 2003 and Corel
WordPerfect Office 12 next month
with a look at the spreadsheets (Excel
2003 and Quattro Proj and the pre-
sentation programs (PowerPoint 2003
and Presentations 12). per

by Greg Shultz

Micrasoft Werd 2003

The Verdict

The Encarta Dictionary is available in the Research pane and pro-
vides excellent definitions, However, in order to use it, you must
have an Internet connection.

The Barch Conversien Wizard walks you through converting a va-
riety of document formats to Word,

Using the Save As command 1o save documents in HTML, XML, and
WordPerfect formats is easy.

Can easily import HTML and WordPerfect documents from the File
Open dialog box.

Access the Font drop-down menu and each font name displays in
that font.

The Reveal Formatting task pane provides a list of the formatting
aptions you can apply to the selected text

An ample set of formatting features is available from the Formatting
toalbar and on the Format menw. Creating and editing soes is an
easy task in the Seyles And Formatting pane.

By default the Check Crammar As You Type feature is enabled.
Ward performs a manual grammar check at the same time as a
manual spell check.

The Help menu provides access to Word Help, the Office Assistant,
and Word Perfect Help, You also have access to the comprehensive
Microsoft Office Online Web site and Office Updare.

Each document appears as a separate button on the Windows
Taskbar.

The small, paperback-sized, 42-page getting started guide provides
installacion information and brief overviews of new features.

By default, the Check Spelling As You Type feature is enabled and
immediately underlines misspelled words. You can perform a
manual spell check by clicking a butten on the wolbar or by
pressing F7.

Selecting the New command opens the New Document pane where
you can access licerally hundreds of document templates, both lo-
cally and on the Micrasoft Office Online Template page,

Saving Word documents in XML formar is a snap due to the auro-
matic application of the WordML schema. However, if you need o
delve into the actual XML tags, you're out of luck.

The Encarta Dictionary's definitions are much more detailed than those
in the Oxford dictionary version. Also the fact that WordPerfect
prompts you to purchase a different dictionary is a bic of a lecdown.

Although the Conversion Wizard and the Conwversion Utility approach
the task from different interface perspectives, they both perform the
task commendably. 3o this one's a tie,

Having a separate toolbar that is easy to use and access, as well as having
the ability ro save documents in POF formar, puts WordPerfect over the
top.

Both programs can easily import HTML as well as each other's
documents.

‘When it comes to experimenting with fonts, WordPerfect's font preview
method comes out way ahead of Word's method.

‘When it comes to changing formatting options, Word's Reveal
Formatting feature is quicker. When it comes to unraveling botched for-
marting, WordPerfect's tag display is easier. This one's a tie.

Both programs offer such similar features when it comes to formatting
and styles, that this is easily a tie.

The grammar checking tools in bath programs are very similar in opera-
tion and usability. However, WordPerfect's Crammatik offers more thor-
ough explanations.

Bath Help systems are excellent and provide tons of assistance, locally
and via the Web. This one's a tie.

‘WordPerfect's application bar provides a more sensible solution to man-
aging multiple open documents.

Although Word's lack of a manual is more than made up for with the
amount of content on the Microsoft Office Online Web site, having a
prinved manual is still a big plus. WordPerfect wins this one,

Both on-the-fly spell checkers perform similarty, A manual spell check in
‘Word opens a dialog box with only suggested comrections. A manual
spell check in WordPerfecr opens a tabbed panel thar not only offers
suggested corrections but also provides quick acoess vo Grammatik, the
thesaurus, and the dictionary.

Although both programs go about praviding access to their templates in
slightly different ways, the type, quality, and number of available tem-
plates is essentially the same.

Ifall you need to do is generate basic XML, then either program will do
the job, However, if you want more sophisticared XML tools, then
WordPerfect is your match.
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